
Micro Focus Academic
Program 10.0

Release Notes



Micro Focus
The Lawn
22-30 Old Bath Road
Newbury, Berkshire RG14 1QN
UK
http://www.microfocus.com
  

© Copyright 2024 Micro Focus or one of its affiliates.

MICRO FOCUS, the Micro Focus logo and Visual COBOL are trademarks or registered
trademarks of Micro Focus or one of its affiliates.

All other marks are the property of their respective owners.

2024-07-12

ii



Contents

Micro Focus Academic Program 10.0 - Release Notes ...................................4
What's New ......................................................................................................................... 5

Rocket COBOL and Enterprise Extensions for Visual Studio Code .........................6
Application Workflow Manager .................................................................................7
.NET Support ........................................................................................................... 7
COBOL Language ....................................................................................................7
Code Analysis and a Natural Language Analysis Assistant .....................................8
Compiler Directives .................................................................................................. 8
Customer Experience Improvement Program .......................................................... 8
Data Tools ................................................................................................................ 8
Database Connectors ...............................................................................................9
Eclipse Integration ....................................................................................................9
Enterprise Server ................................................................................................... 10
Enterprise Server Common Web Administration (ESCWA) ................................... 10
Enterprise Server Security ..................................................................................... 11
IMS Support ........................................................................................................... 11
Interface Mapping Toolkit ........................................................................................11
Licensing Changes .................................................................................................11
Mainframe Access ..................................................................................................12
Micro Focus Unit Testing Framework ..................................................................... 12
PL/I Support ........................................................................................................... 12
Terminal Emulation .................................................................................................13
Visual Studio Integration ........................................................................................ 13

Significant Changes in Behavior or Usage ........................................................................13
Known Issues ....................................................................................................................25
Installation ......................................................................................................................... 25

System Requirements ............................................................................................ 25
Installation Restrictions and Requirements ............................................................27
Downloading the Products ..................................................................................... 28
Installing the Products ............................................................................................ 28
After Installing .........................................................................................................28
Repairing ................................................................................................................29
Uninstalling .............................................................................................................29

Copyright and Disclaimer .................................................................................................. 30

Contents | 3



Micro Focus Academic Program 10.0 -
Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Overview

The Micro Focus Academic Program brings contemporary software development tools and technologies to
COBOL development helping to bridge the gap between the old and the new.

COBOL applications still run many of the world’s business systems, therefore teaching the COBOL
language is a great way to prepare your university's students for a robust IT career in today’s economy.

The Micro Focus Academic Program is designed to support the education and use of the COBOL language
within the academic setting. This program supports our academic partner community through the use of
our COBOL development tools and materials within the classroom.

This program will enable your university to quickly join this growing league of similar academic
organizations in support of the promotion and education of the COBOL language.

Welcome! We’re excited to have you join our growing academic community.

Product Description

The Micro Focus Academic Program Edition package comprises the following products:

• Visual COBOL - delivers the richest development experience for COBOL programming. On Windows,
Visual COBOL is available for use with Microsoft's Visual Studio or with the Eclipse integrated
development environments. On UNIX or Linux, it is available for use with Eclipse. Visual COBOL
supports the development and deployment of both JVM COBOL and .NET COBOL, and of native
COBOL applications.

Variants of Visual COBOL include:

• Visual COBOL for Visual Studio 2022
• Visual COBOL for Eclipse (Windows)

• Enterprise Developer - a contemporary development suite for Microsoft Visual Studio or for Eclipse that
enables mainframe developers to maintain, develop and modernize mainframe applications regardless
of whether these are to be deployed back on the mainframe or onto an alternative platform. Enterprise
Developer supports IBM COBOL, IBM PL/I, IBM Assembler, IBM CICS, IBM IMS, IBM JCL, IBM DB2,
IBM z/OS file formats and common batch utilities including SORT. This means you can develop and
maintain the core mainframe online and batch applications under Enterprise Developer, then deploy
them back on the mainframe or migrate them onto one of the Micro Focus production platforms
available on UNIX, Linux, or Windows. Variants include:

• Enterprise Developer for Visual Studio 2022
• Enterprise Developer for Eclipse

Micro Focus Academic Program differs from the full version of these products in a number of ways. The
differences are:

• You cannot deploy applications on other machines, so Micro Focus COBOL Server and Enterprise
Server are not supplied.
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Note: Micro Focus Academic Program is supplied for Academic use only. It is not to be used for any
commercial purposes. You must be a registered Micro Focus Academic Program Partner in order to
use this software.

For more information, follow the link in the Electronic Product Delivery email for the End User License
Agreement.

Reporting Issues

• For the latest information and discussions on this product, or to report issues, visit the Micro Focus
Community Web site.

Note:

• This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.

• Check the Product Documentation section of the OpenText Support and Services Documentation
Web site for Micro Focus products for any documentation updates.

Upgrading from earlier Micro Focus products

This version of your product is dependent on a later version of the Microsoft C run-time system than earlier
Micro Focus products. This means that COBOL executables (.exe) built with a version earlier than 4.0
might not be compatible with the current version of the run-time products. If the behavior of your application
changes with the current version, we strongly recommend that you relink the main executable with the
current version. This will ensure that the COBOL run-time system fully handles any run-time error
conditions that might occur.

A new executable that is fully compatible with the current version can be produced without recompiling the
application, as long as the original object code is available and it is relinked with the current version.

To allow your executables to benefit from the product's latest programming and performance
enhancements, we recommend a full recompilation of your source code.

If you are using Visual Studio, you can configure the IDE to automatically check whether applications
created with older releases must be relinked. If the application uses an older version of the C run-time
system, Visual COBOL can automatically relink the existing executable or .dll to the new version of the C
run-time system without the need to recompile the application first. If a project needs relinking, Visual
Studio displays a message in the status bar providing an option for you to choose and relink the project.

If you are using Eclipse, Visual COBOL can automatically relink existing projects created with Visual
COBOL earlier than 4.0 that have executable link artefacts. Eclipse displays a warning in the Problems
view that the project requires relinking. It then offers a Quick Fix action for you to execute that will link your
project with the most recent version of the Run-Time System.

What's New
This What's New? document covers some of the new features and functions in the latest release of the
Micro Focus Enterprise Product Suite. Updates apply to the following products:

• Micro Focus Enterprise Developer which provides a contemporary development suite for developing
and maintaining mainframe applications, whether the target deployment is on or off the mainframe.

• Micro Focus Enterprise Test Server which provides a comprehensive test platform that takes
advantage of low cost processing power on Windows environments, to supply scalable capacity for
testing z/OS applications without consuming z/OS resources.
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• Micro Focus Enterprise Server which provides the execution environment to deploy fit-for-purpose
mainframe workload on Linux, UNIX and Windows (LUW) environments on IBM LinuxONE (IFLs),
standalone servers, virtual servers, or the Cloud.

• Micro Focus Enterprise Server for .NET which provides the execution and modernization platform to
deploy fit-for-purpose mainframe workload on a scale-out .NET infrastructure and the Azure Cloud.

This document helps you to quickly understand the new capabilities within the 10.0 release.

Enhancements are available in the following areas:

• Rocket COBOL Extensions for Visual Studio Code
• Application Workflow Manager
• .NET Support
• COBOL Language
• Code Analysis and a Natural Language Assistant
• Compiler Directives
• Customer Experience Improvement Program
• Data Tools
• Database Connectors
• Eclipse Integration
• Enterprise Server
• Enterprise Server Common Web Administration (ESCWA)
• Enterprise Server Security
• IMS Support
• Interface Mapping Toolkit
• Licensing Changes
• Mainframe Access
• Micro Focus Unit Testing Framework
• PL/I Support
• Terminal Emulation
• Visual Studio Integration

Rocket COBOL and Enterprise Extensions for Visual
Studio Code
Back to Top

The Micro Focus COBOL and Enterprise extensions for Visual Studio Code have been repackaged by
Rocket Software on the Microsoft Visual Studio Marketplace.

• The Rocket COBOL extension for Visual Studio Code (formerly Micro Focus COBOL Extension for
Visual Studio Code) provides COBOL edit, compile and debug support for Visual COBOL and
Enterprise Developer users in Visual Studio Code.

• The Rocket Enterprise extension for Visual Studio Code (formerly Micro Focus Enterprise extension for
Visual Studio Code) provides PL/I edit, compile and debug support for Enterprise Developer users in
Visual Studio Code. This extension installs the Rocket COBOL extension.

• The Rocket JVM COBOL extension for Visual Studio Code (formerly Micro Focus JVM COBOL
extension for Visual Studio Code) provides support for debugging JVM COBOL code in Visual Studio
Code.

• The Learn COBOL extension for Visual Studio Code provides all training materials for the Micro Focus
COBOL Fundamentals Training course.

New enhancements in this release are:

• Support for accepting command-line arguments in COBOL notebooks.
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• New debug launch options - console and integrated Terminal support for platform specific values in the
launch.json file.

• Support is available for fine-tuning the colors of different parts of the code in the editor via Visual Studio
Code's settings.json file. This requires a minimum release 10.0 of Visual COBOL.

Note: These extensions are not included with the Visual COBOL or the COBOL Server installer. They
are available from the Microsoft Visual Studio Marketplace website. All of the extensions are available
on Windows and Linux.

Application Workflow Manager
Back to Top

This release includes the following improvement:

• Two new tools, Get Editor Content and Set Editor Content, have been added to the Eclipse function
package. These tools enable you to copy or set the content of an Eclipse text editor to or from a string
or file. For example, you can use these tools to change the editor content by an external script written in
Python or PowerShell. See Tool Types for the Eclipse Function Package in your product Help.

.NET Support
Back to Top

This release provides the following enhancements to .NET support:

• .NET COBOL projects now target .NET 8. You can use Visual Studio, .NET 8 SDK or Visual Studio
Code to build .NET 8 COBOL projects. Earlier versions of .NET are not supported. Support for
building .NET Framework 4.x COBOL projects using Visual Studio remains unchanged.

COBOL Language
Back to Top

This release includes the following enhancements:

• The FREE statement - under the MF dialect, you can now free memory, allocated via the ALLOCATE
statement, directly by using FREE ADDRESS OF data-name. This negates the need to specify a
returning pointer during allocation (i.e. ALLOCATE data-name RETURNING my-pointer) and then
freeing the pointer.

• COBOL/Java interoperability - the following features have been added to the COBOL and Java
interoperability for native COBOL code:

• Support for the use of dynamic length COBOL items when running under an MF dialect. See
Mapping COBOL Items and Java Types.

• User-defined exception handling when calling Java static methods. See Example 5 - Exception
Reporting When Calling Java Static Methods.

• The entry_point_mapper_disable_auto_aliasing run-time tunable - this new tunable has been
introduced to determine whether the Entry Point Mapping facility should not emulate the alias function of
an IBM mainframe linkage editor, and instead generate a COBRT173 Called program file not
found in drive/directory run-time system error.

• Enterprise COBOL support - the following enhancements provide greater compatibility with IBM
Enterprise COBOL version 6.4:

• The STRING and UNSTRING statements now support USAGE UTF-8 data items.
• The ENCODING phrase of the JSON-GENERATE and JSON-PARSE statements is now supported.
• The ENTRY-NAME and ENTRY-INTERFACE clauses of the Function-ID paragraph are now

supported; however, these clauses are strictly documentary.
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• New MF Level - this release includes a new default level (MF"23") of reserved words. See Reserved
Words Table for words associated with this level.

• Pointer dereferencing - improvements have been made in the ability to dereference pointers using
both the DATA...AT and :: (colon-colon) syntax. See Pointer Dereferencing.

Code Analysis and a Natural Language Analysis
Assistant
Back to Top

This release includes the following enhancements related to integration with COBOL Analyzer and
Enterprise Analyzer:

• Natural Language Analysis Assistant in the IDE - integration with COBOL Analyzer and Enterprise
Analyzer now provides a natural language Analysis Assistant chat window in the IDE. You can type
queries about a COBOL workspace in a COBOL Analyzer or an Enterprise Analyzer repository. From
the Analysis Assistant window results you can open Program Flow Graphs, view Complexity Reports,
and open COBOL source files.

Note: This functionality requires a licensed copy of either COBOL Analyzer 10.0 or Enterprise
Analyzer 10.0.

• Complexity reports (Eclipse only) - you can now generate a Complexity Report for a workspace in the
Application Server Explorer view. A complexity report enables you to view and compare various
metrics of files in your workspace.

• On Windows inside Eclipse, the Program Flow Graph (a Windows-only feature) is now available from
Server Explorer for workspaces and source files in COBOL Analyzer and Enterprise Analyzer in the
Eclipse IDE.

Compiler Directives
Back to Top

The following Compiler directive is new in this release:

• ILPOINTER-REFERENCE - Determines how a pointer used as a method parameter is passed if BY
VALUE or BY REFERENCE is not specified as part of the parameter.

Customer Experience Improvement Program
Back to Top

Starting this release, the Customer Experience Improvement Program collects high-level, anonymous
information on how Micro Focus products are used. The information collected includes product name and
version, OS in use, and features used with the purpose to improve the products and, consequently, the
customer experience.

Customer Experience Improvement Program participation is enabled by default. You can opt out with the
help of the mfceipconfig command-line utility.

Data Tools
Back to Top

This release includes the following enhancements in the Enterprise Developer and Enterprise Server
products:
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Attention: This feature is in Early Adopter Program (EAP) release status. We intend to provide the
finalized feature in a future release. Please contact OpenText Support for Micro Focus Products if you
require further clarification.

• A new Data Tools utility, an Eclipse-based RCP (Rich Client Platform) application, is available. The new
Data Tools is designed to overcome several restrictions in the existing Data File Tools and Classic Data
File Tools. The new Data Tools application is a multi-line editor where the previous Data File Tools
support editing one line at a time. Changes are made in the editor window, not in a separate line at the
bottom of the editor.

• A new REST-based file service API is now available. This enables you to access Micro Focus formatted
data sets as follows - get dataset attributes, open or close datasets, get or set a dataset’s content, and
to create datasets. The API commands can be used in customer scripts to access datasets with Micro
Focus formats to automate application development processes. The REST-based file service API is
used by the new Data Tools utility.

Features of the new Data Tools include:

• Open/save of Enterprise Server-cataloged datasets of the following Micro Focus formats: Fixed blocked,
Variable blocked, and Indexed

• Multi-line editing support
• Insert, delete, update of lines or records
• Different coloring of changed lines/records to highlight changes
• Undo/redo
• Page-based navigation
• Toggle HEX on/off
• EBCDIC/ASCII switch
• Options for specifying the fonts and colors
• Display file information in a separate view
• Comprehensive logging and tracing capabilities

Database Connectors
Back to Top

• The CARRIAGE-CONTROL-FILTER XFD directive - enables carriage control characters to be retained
when AcuXDBC reads a LINE SEQUENTIAL data file.

Eclipse Integration
Back to Top

This release provides the following enhancements:

• Visual COBOL supports, and is shipped with, Eclipse 4.28 (2023-06). Versions of Eclipse prior to this
one are not supported.

• Quick fixes - quick fix functionality has been enhanced to provide a list of possible fixes that can
automatically be applied from the popup box displayed when hovering over an error in the editor; this is
similar to the functionality provided when working with Java.

• Session profiles when using Reflection Desktop or Rumba+ Desktop as your TN3270 emulator -
you can specify an existing session profile to automatically use when you connect to your emulator
when running or debugging your mainframe subsystem project. See Choosing a TN3270 Mainframe
Display in your product Help.

• Pre- and post-build processing events - script files used as part of build processing events
(Properties > Micro Focus > Build Configurations > Events) can now be coded to affect the
outcome of the COBOL build process, and also introduce error messages into the IDE. See Pre- and
post-build processing events.
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• Copybook Graph support - you can now see a graph of the copybook dependencies of COBOL files.
The graph enables you to see any incoming and outgoing dependencies.

• Copybook Paths preference - a new preference page has been introduced to help locate copybook
files, referenced in standalone files, when debugging. Use this page if your copybook files (or the files
that call them) have been moved from their original (built) location. The list is searched in order until a
match is found.

• Conditional breakpoints when debugging JVM COBOL now support the use of the following
operators: <, >, <=, and >= within expressions.

• Formatting preferences applied on sentence termination - a new formatting preference (Window >
Preferences > Micro Focus > COBOL > Editor > Typing > Format sentence on period) formats the
current sentence as per the current formatter profile settings, when it is terminated by a period.

Enterprise Server
Back to Top

This release provides the following enhancements:

• Remote File Access - it is now possible to remotely access files using a configured Remote File Access
(RFA) MFCS Connector. You can access ordinary files, cataloged datasets, and spool output. This also
enables remote editing of COBOL data files using the new Data Tools utility. This enables you to
download and upload files, datasets, and spool output locally or remotely using the existing Enterprise
Server Security configuration. Various security features make this solution a more secure alternative to
more generic solutions such as FTP and SSH.

Enterprise Server Common Web Administration
(ESCWA)
Back to Top

This release includes the following enhancements:

• Catalog view has improved filtering options and now includes paging. A new Load on navigation check
box enables you to filter based on the previously selected conditions. See Catalog List in the product
Help.

• A new Configuration Report page enables you to visualize potential security vulnerabilities in the
ESCWA and MFDS configurations. Each domain and configuration attribute combination has its own
help dialog. See Configuration Report in the product Help.

• Role-based security configuration. You can now configure a users view of ESCWA. If a user does not
require specific roles then you can hide corresponding pages and API. You can configure the role-based
access from the Role Options page. Click Security , expand ESCWA Configuration followed by the
ESM, and then click Roles. See Role Options in the product Help.

Note: Role-based security is an ESCWA only feature that works on top of existing product security.

• It is now possible to remove Locks, if necessary, to fix applications that are broken due to a lock that has
not been removed. You can enable this feature from the Locks page. Click Native > Monitor > Locks,
and then click Remove Locks. This functionality is controlled by the casstop resource entity in the
OPERCMDS resource class. See Locks in the product Help.

Caution: Incorrectly removing locks can result in system instability and corruption or loss of data.

• Region verification - ESCWA can now verify the configuration of selected components for an enterprise
server region. You can use this feature to identify potential start up or configuration issues for the
selected region. The verification process uses the casverify utility to perform the verification action. See
Verify in the product Help.

• Improved CICS resource navigation. Active resources can now be filtered by group and large sets of
filtered data can be paged.
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• The API return codes have been improved. Previously, when the region monitor and control APIs were
called, they would return a HTTP 200 code, with the error specified in the JSON output. The return
codes have been improved to give more information. You can configure the API to use the new or old
behavior.

• The ESCWA user interface is now more responsive and can be used with a greater variety of smaller
Web browsers.

Enterprise Server Security
Back to Top

This release includes the following enhancements:

• Enterprise Server security features provided by the VSAM External Security Manager (ESM) module
are enabled by default. You will need to supply valid credentials when you interact with ESCWA, the
Micro Focus Directory Server and regions in the browser based UI or in the IDE, use certain utilities
from the command line, use TN3270 emulator to access regions, log into or with FileShare. See After
Installing > Enterprise Server Security Features for details on how to configure this product.

• TLS Certificate Checking Utility - a new executable in the product that can be used to help diagnose
problems with TLS certificates. It can check the validity of certificates, verify certificate chains, check
that certificates and private keys match and check that a certificate contains a SAN that matches a
provided hostname/address. Improves TLS usability by diagnosing TLS certificate problems. See
CertChecker Utility for more information.

• The VSAM ESM Module, which provides file-based security for Enterprise Server is now a GA quality.

• User authentication and resource authorization control can be enabled through a simple file-based
security mechanism.

• Security data can be imported from YAML or LDIF and exported to YAML for portability and ease of
editing / scripting.

• Additional optional security features are available for HTTP and MFBINP conversations, for the Web
Services and J2EE, Web, and Remote File Access conversation types. Listeners can be configured to
require user authentication and/or to restrict access to specific types of requests. See Enhanced
Security for HTTP and MFBINP for more information.

IMS Support
Back to Top

This release provides the following new features:

• APARM handling has been updated to use EBCDIC APARMs obtained from EBCDIC applications. In
addition, the APARM positional parameter for DLI has been changed from 19 to 20 to be consistent with
the IBM IMS documentation. The APARM positional parameter for BMP applications remains at 19.

• The ES_IMS_APARM_DLI environment variable has been added to enable the APARM handing
behavior of previous releases.

Interface Mapping Toolkit
Back to Top

This release provides the following enhancement:

• The imtkmake -defmap command now support the following new parameters that enhance the
default mapping support for service interfaces - entrypoint, method, and path.

Licensing Changes
Back to Top
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• The SafeNet Sentinel licensing system that was available with previous releases of this product has
been deprecated and is no longer available in release 10.0. This product also uses the Micro Focus
AutoPass licensing technology which was introduced in release 8.0. Starting with release 10.0,
AutoPass is the only licensing technology available in this product.

• The SafeNet Sentinel licenses are no longer supported, and you need to use AutoPass licenses starting
with release 10.0. Contact your account manager to replace your existing SafeNet Sentinel with
AutoPass licenses.

Note: Installing 10.0 on a machine where there are other Micro Focus products or versions installed
that use SafeNet Sentinel licensing might result in some compatibility issues. While the 10.0
installation process has been designed to address such issues, you should be aware of the following
scenarios and if any action might be required to ensure licensing works as expected. See Advanced
Installation Tasks > Licensing Coexistence when Upgrading to Release 10.0 in the Installation section.

Mainframe Access
Back to Top

This release includes the following new features:

• z/OSMF support - MFDAS and Syncmon now have access to mainframe-hosted PDS files using the z/
OSMF interface. This enables you to list and download PDS files without having to install Mainframe
Access Server. See Using z/OSMF in your product Help.

Micro Focus Unit Testing Framework
Back to Top

This release includes the following enhancement:

• A new configuration file format has been introduced that enables you to use environment variables in
your unit test code for tests that are compiled for more than one scenario. A portable environment file
can provide environment variables for a test case that has been compiled in multiple ways (for Windows/
UNIX, 32-bit/64-bit, etc...). See Configuring the Run-Time System Environment in your product Help.

PL/I Support
Back to Top

This release provides improvements in the following areas:

Open PL/I compiler:

• Support for ORDINAL data types.
• Support for ORDINALNAME, ORDINALPRED and ORDINALSUCC ordinal built-ins.
• New -gen_entry_dcl compile option which will automatically generate ENTRY declarations and write

them to the specified file.
• Improved mainframe compatibility of E and F edit FORMATs.
• Optimizer inlining support to improve performance. The new -noinline compiler option prevents the

optimizer from attempting to inline PROCEDURE or BEGIN blocks.
• Support for UPTHRU and DOWNTHRU in loop iterations.
• Support for the TRANSMIT condition.
• Compiler cross-reference listings now indicate which variables and other identifiers are unreferenced

and where they are declared within include files. Compiler cross-reference listing also include unique
statement IDs to help correlate diagnostics to ambiguous line numbers within generated macro
expansion.

• Support for static data structures and arrays exceeding 2GB in size (with the -largedata compile option).

Open PL/I debugger:
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• Support for ORDINAL data types.
• Simplified debugger experience in Enterprise Server by removing PL/I tab from ESCWA.
• Support for asterisk (*) variable names in PL/I structures.
• Improved overall debugger performance when handling large arrays and/or structures.

Open PL/I Run-Time System:

• Improved support for controlled storage in CICS transactions running in Enterprise Server.
• Support for the TRANSMIT condition.
• Improved support for ENDPAGE emulation.

Terminal Emulation
Back to Top

This release includes the following enhancements:

• Host Access for the Cloud shipped with this product is now version 3.0.0.2. The HACloud configuration
file has changed is now the application-userprefs.properties file in %ALLUSERSPROFILE%
\Micro Focus\Enterprise Developer\hacloud (Windows) or $COBDIR/etc/hacloud
(UNIX). If there is an existing hacloud.properties file in from an earlier Visual COBOL release in
%ALLUSERSPROFILE%\Micro Focus\Enterprise Developer, this file is backed up the first time
you start the HACloud session server. Micro Focus recommends that you migrate any non-default
settings from the older configuration file over to the application-userprefs.properties file after
the upgrade. See HACloud Configuration File for details.

• For secured ESCWA scenarios, HACloud now retrieves credentials for the ESCWA connection from a
default secret shipped with the product (in microfocus/common/readonly). You can override the default
user credentials by supplying an escwacreds and/or an mfdscreds secret. If these secrets do not exist
then the default supplied user will be used.

Visual Studio Integration
Back to Top

This release provides the following enhancements:

• Colorization of items in the editor - there are now more COBOL items that you can configure the editor
colors for from Tools > Options > Environment > Fonts and Colors.

• Server Explorer enhancements - you can now connect to a remote ESCWA, and add remote Directory
Servers to the ESCWA opened in Server Explorer.

Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

• Licensing Changes
• Significant Changes in Behavior or Usage - Enhancements
• Significant Changes in Behavior or Usage - Fixes

Licensing Changes

Back to the list

• With release 10.0, the SafeNet Sentinel licensing technology has been deprecated. This can result in
some compatibility issues if you install 10.0 on a machine where there are other Micro Focus products
or versions installed that use SafeNet Sentinel licensing. While the 10.0 installation process has been
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designed to address such issues, you should be aware of the following scenarios and if any action
might be required to ensure licensing works as expected. See Advanced Installation Tasks > Licensing
Coexistence when Upgrading to Release 10.0 in the Installation section.

Significant Changes in Behavior or Usage - Enhancements

Back to the list

The numbers that follow each issue are the Support Case Numbers followed by the Issue number (in
parentheses).

• Data Tools
• Eclipse IDE
• Enterprise Server
• File Handling
• IMS Support
• PL/I Support
• SQL: HCO for SQL Server
• SQL: Mainframe Batch Database Tools

Data Tools

Back to the list

• In the new Data Tools Editor, positioning is no longer lost when switching between character and HEX
mode.

02526087 (410104)
• The new Data Tools Editor has a preference page that allows users to adjust the font size of various

editor parts.

02315408 (285050)

Eclipse IDE

Back to the list

• A new smart editing preference - Format sentence on period - which formats a sentence according to
the current formatter profile when it is terminated with a period, can be configured from Window >
Preferences > Micro Focus > COBOL > Editor > Typing.

(8294)

Enterprise Server

Back to the list

• Enterprise Server's PAM ESM Module now has a group-filter option that can be used to ignore all user
groups that do not matching a specified pattern. See PAM ESM Module Custom Configuration
Information in your product Help for more information.

3176983 (12500)
• In ESCWA, the Enable Single Sign-On for Unsecured Resources has been renamed to Single Sign-

On Behavior which has three options:

• Disabled - This disables all single sign-on including live enterprise server regions.
• Only Secure and Loopback - This is the old 'default' behavior, single sign-on will be enabled for

secured and localhost resources.
• Allow Insecure (All) - Single sign-on will be enabled for everything. This list controls two boolean

configuration attributes specified in the commonwebadmin.json file:
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• InsecureAutoSignOn - this is an existing attribute.
• DisableAutoSignOn - this is a new attribute, if this is set to true then InsecureAutoSignOn will

have no effect and all single sign-on will be disabled. If set to false then InsecureAutoSignOn
will operate as before.

02663941 (658042)
• In ESCWA, on the Spool page you can now specify default filters for all users. See Spool in your

product Help for more information.

02497901 02573796 (465005)
• In ESCWA, you can now set table column defaults for users. This can be configured from the column

filtering option of the table in ESCWA. If an administrator has not set table defaults then the table
columns displayed will match the ESCWA defaults. You can specify which users are able to configure
default columns. This can be performed by modifying the Table Column Configuration security
resource entity. See Security Resources to Control ESCWA and API Access in your product Help for
more information.

Note: If Table Column Configuration is not specified then ESCWA will use the configuration
specified for the Common Web Administration resource class.  

02618280 (532051)
• The casverify utility has been improved with new functionality and additional verification stages. See

casverify in your product Help for more information.

Note: The changes to its text and JSON output formats are incompatible with earlier versions.

(527008)

File Handling

Back to the list

• ICETOOL emulation now supports WRITE, DIGITS and WIDTH for the COUNT operator.

02650300 (539002)
• A new EXTFH config option, FLUSHSYSOUT, has been introduced. FLUSHSYSOUT=ON (which is the

default setting) enables you to view records for an active spool job as they are written/opened. This new
setting is not as performant as the previous behavior (which you can reinstate using
FLUSHSYSOUT=OFF) where records for an active spool job would only be displayed after a
determined buffer size was written to.

02641736 02658226 (528102)

IMS Support

Back to the list

• The new ES_IMS_LINKAGE_NULL environment variable has been added to handle a scenario in which
more linkage items are passed by the program than there are PCBs in the PSB. When
ES_IMS_LINKAGE_NULL=Y, extraneous linkage items are assigned a value of NULL.

02796708 (665033)
• APARM handling has been updated to use EBCDIC APARMs obtained from EBCDIC applications. In

addition, the APARM positional parameter for DLI has been changed from 19 to 20 to be consistent with
the IBM IMS documentation. The APARM positional parameter for BMP applications remains at 19. The
ES_IMS_APARM_DLI environment variable has been added to enable the APARM handing behavior of
previous releases.

02709072 (614050)
• You can now configure MFS to support input type option 2 just as it supports option1. To enable this, set

the new ES_IMS_MFS_OPT2_LEGACY environment value to Y. This enables legacy MFS input type
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option 2 behavior. When set to N, MFS input type option 2 behavior is like on MFS on z/OS mainframes.
The default is N.

02614651 (515070)

PL/I Support

Back to the list

• The internal consistency error in the PUT EDIT statement with a DO-loop that was never iterated has
been fixed; however, we recommend avoiding dead DO-loops in PUT EDIT statements as they result in
redundant code.

02518315 (407194)
• The DO UPTHRU and DO DOWNTHRU options are now supported for both arithmetic and ordinal

types.

00366167 (11718)
• PL/I now supports the ORDINALNAME, ORDINALPRED, and ORDINALSUCC built-in functions. This

support is provided in this release as an Early Adopter Product (EAP) feature.

00366176 (12535)
• Support for the PL/I FORMAT statement has been updated. The repetition value limit for the repeat field

has been increased from 255 to 999999.

02382223 (333007)
• The Open PL/I compiler now supports the -initautuo, -initbased, -initctl, and -initstatic options.

02725021 (623003)
• The Open-PLI compiler now supports unique statement ID numbers in the compiler listing file. The -stmt

compiler option (or *PROCESS STMT) enables this feature. The statement ID numbers are enclosed in
curly braces, e.g. {367} for easy identification in the listing. Likewise, the associated statement ID for a
given line is included in compiler listing diagnostics. This can be particularly effective during macro
expansion when line numbers in the listing file are held constant and a compilation error occurs due
incorrect PLI code in the expansion of the macro.

02501000 (401114)

SQL: HCO for SQL Server

Back to the list

• The HCOSS Define Lists UI has been enhanced to enable you to select a dependency mode to use
when creating a transfer list. The available modes are:

• Default - Automatically include all parent objects of the selected object.
• Family tree - Automatically include all parent objects of the selected table and the child objects of

each parent object
• No dependency handling - Do not include any parent or child objects of the selected table. In

addition, the start and end date and time for each table transfer is now part of output when
transferring data.

02544930 (440008)

SQL: Mainframe Batch Database Tools

Back to the list

• The SQLTUL tool has been updated to enable you to specify that the return code (RC=04) for execution
of non-SELECT * statements should match the mainframe DSNTIAUL return code. The default is to not
match the return code, but to return RC=0. In addition, the -r option has been added to the
mbdtconfig command to enable the same functionality from the command line.
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02669700 (547020)

Significant Changes in Behavior or Usage - Fixes

Back to the list

The numbers that follow each issue are the Support Case Numbers followed by the Issue number (in
parentheses).

• Application Workflow Manager
• CICS Support
• Compiler
• Eclipse IDE
• Enterprise Server
• File Handling
• Host Access for the Cloud
• IMS Support
• Interface Mapping Toolkit
• JCL Support
• Mainframe Access
• Micro Focus Batch Scheduler Integration
• Micro Focus Directory Server
• PL/I Support
• Run-Time System
• SQL: Mainframe Batch Database Tools
• Visual Studio IDE

Application Workflow Manager

Back to the list

• The name of the connection type Micro Focus z/Server" in the Remote Systems view has been
changed to Micro Focus z/OS.

(58344)

CICS Support

Back to the list

• When an FCT entry had the start empty property set either in the definition itself or via a SET FILE
EMPTYSTATUS(EMPTYREQ) command, the file was emptied on every OPEN. This was not in line with
mainframe behavior. In this release, setting the start empty property now causes the file to be emptied
only on the next OPEN, which aligns with mainframe behavior.

02746607 (633025)

Compiler

Back to the list

• The intrinsic function LENGTH and special register LENGTH OF were not always returning the correct
result for PIC N NATIONAL fields. These have been updated to the correct behavior, namely returning
the number of characters for the former and number of bytes for the latter. If your legacy code has been
relying on the previously incorrect behavior, results might now differ.

(613039)
• Generated code only (excluding Intel x86 32-bit platforms): an error when moving from a COMP-6 item

to another COMP-6 item when the SIGNFIXUP Compiler directive is specified has been fixed.
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(665005)

Eclipse IDE

Back to the list

• The Skip all breakpoints option, available in the Breakpoints view for COBOL programs, can now be
toggled on and off during an active debug session.

(429042)
• From the Server Explorer in Eclipse, remote catalog entries can now be opened in the Data File

Editor when they are running through a Fileshare server.

(485063)
• A new preference can be set within Eclipse to add search paths for copybooks within standalone files.

Select Windows > Preferences > Micro Focus > COBOL > Standalone Files > Copybook Paths,
and then add one or more paths (or environment variables containing paths) to be searched when
debugging. When the paths in a symbols file cannot be found (for example, source has moved and
debugged from a different location) the missing copybooks are searched for along these paths until a
match is found.

02598103 (517053)
• A new preference, Preserve Ant build file for Maven projects has been added to the Micro Focus >

Builder preference page. Select this option to automatically create a build file (.cobolBuild) when
importing a Maven project.

02540902 (443016)
• The PL/I launch configuration for remote projects using the SSH Only connection now allows the Use

X-Server setting to be unchecked, and the output of a program to be displayed in the Eclipse console.
This is permitted when running an application, but the use of an X-Server is still necessary when
debugging, and so this option must be selected for that scenario, otherwise an error is shown.

(420024)
• For new workspaces, the Server Explorer view no longer contains a connection to the local ESCWA

server by default. You must add the connection manually, when required.

(656022)
• When launching Rumba Desktop or Reflection Desktop (as your TN3270 emulator) from within Eclipse,

you can now select a custom profile with which to start the session; see Choosing a TN3270 Mainframe
Display within the product documentation for more details.

02498222 (403108)
• New COBOL projects created under a Japanese locale now default to a source encoding of UTF-8. This

new default can be changed by a new preference setting in Preferences > General > Workspace >
Source encoding directives. Also, within each project, this setting can be overridden at the usual project
levels (project settings, build config, etc...) by using the SOURCE-ENCODING directive. Additionally, the
COBOL project settings (Properties > Micro Focus > COBOL) contain a new setting - source-
encoding - which also explicitly passes through the file encoding to the Compiler. This setting can be
used instead of the previous method of specifying the SOURCE-ENCODING directive within Additional
directives.

(481005)
• The option to specify a script file for environment variables has been removed from the Enterprise

Server runtime launch configuration, as it is not supported for this type of configuration.

02661247 (543073)
• The Generate Client wizard now enables you to select YAML files, and use them to generate web

service clients.

(648043)
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Enterprise Server

Back to the list

• An APPC DPL from an enterprise server region to TX Series would result in an ASRA abend on the
enterprise server side.

02686079 (566028)
• When performing a Distributed Program Link (DPL) to a remote system through an intermediate

enterprise server region using a transaction ID that declared a TWA, the program did not run under that
ID and therefore the TWA was not available. This has been fixed and the transaction ID now propagates
through the chain.

02645043 (542077)
• When running with TRANCLASS active, TD Queue transaction triggering was not working.

02737664 (629076)
• In ESCWA, the Catalog list view and the API failed to honor the time value for filters that use date and

time. This has been fixed. Output time values for "created" and "referenced" have been changed in the
Catalog list view to match the format in the Catalog DCB view.

(588011)
• CICS paging is now supported for function shipping. When a SYS62 connection is used, an additional

configuration to the IBM Comms Server is required. A CPMI TP definition is required on the originating
region.

02667779 (583002)
• ASSIGN INVOKINGPROG did not behave correctly when a CALL was involved.

02662244 (543070)
• A DPL over a SYNCLEVEL2 connection could result in an XA start being driven out of sequence

resulting in a protocol error.

02583717 (477027)
• In a TRANCLASS enabled enterprise server region with a high volume of XA transactions, the logging

overhead could cause performance degradation. This has been improved.

02560536 (468059)
• When a transaction invoked across an Inter System Communications link (Transaction Routed)

executed a RETURN IMMEDIATE TRANSID(...), the specified transaction did not run without an AID
key being pressed.

02695470 (665161)
• Running a transaction that produced paged BMS output over a remote connection would incorrectly

result in an AEXJ abend.

02796589 (662007)
• The PAC compatibility checks that run at startup have now been relaxed. Consistent platform and bitism

are still checked, but product version checks are no longer carried out. The
ES_PAC_MIN_COMP_CHECK environment flag has now been deprecated.

Note: Enterprise Server will still carry out record compatibility checks during start up.

(19756)
• The statusCodes flag has been added to some ESCWA API endpoints which can be used to enable

ESMAC to return appropriate HTTP error status codes instead of embedding failure messages in
successful responses. In a future product release, the new behavior will be enabled by default in the
version 2 of the API and the flag will be removed. The version 1 of the API will maintain the current
behavior.

02601489 (506061)
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• ESCWA now limits the session timeout to 20 days. If an existing configuration is greater than that it will
be limited to that value.

(665130)
• In ESCWA, the Listener Properties page now limits user inputs when the smem protocol is selected.

Multiple host names are not permitted, and port selection is also not permitted.

Note: API functionality remains the same.

(665044)
• Remote file and remote SYS ID options can now be modified when adding or editing FCTs with Use

Catalog.

(683164)
• CICS programs referenced the EXCI LINK statement now run under the same user as the

corresponding JCL job.

02747263 (637024)
• Runaway timeout was intermittently incorrectly calculated.

02529887 (468050)
• The JSON output format for the casverify utility has changed. Messages specific to casverify

itself are no longer identified by "msgout" but under a "messages" array.

(570009)
• For Enterprise Server application failure reports and storage dumps generated by runtime errors, the

RTS error code is now taken into account during es-dump-limit (ES_DUMP_LIMIT) processing. Runtime
errors with differing error codes will now be treated as distinct.

02660093 (561067)
• The Allow no-password signon for default users property has been added to the ESCWA Advanced

Region Properties page. If this property is set to false, an explicit signon request with no password
matching an enterprise server default user account will no longer be treated as a no-password verify,
and will instead result in a not authenticated failure.

02728103 (625033)
• Previously, a successful call from JCL to EXCI might result in a ROLLBACK instead of COMMIT.

(504150)
• When no connection string is supplied through ESCWA/MFDS/esfadmin the vsam_esm module will

default to C:\ProgramData\Micro Focus\Enterprise Developer
\es_esm_file_directory.This directory will have been configured through running mfsecconv
init, which is called by the product installer in 10.0 and later.

(545065)
• The es_default_security.yaml file is now supplied with the product and is located at

%ProgramFiles(x86)%\Micro Focus\Enterprise Developer\etc (Windows) or
$COBDIR/etc/vsam_esm (UNIX). You can use this file as a template to configure the VSAM ESM
Module. See the VSAM ESM Module topic in your product Help for more information.

(613052)
• Client connection to Micro Focus Directory Server (MFDS) would sometimes convert a fully qualified

host name to just the simple host name. This could result in TLS connection issues if this did not exactly
match the host names specified in the certificate.

02587914 (486048)

File Handling

Back to the list
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• If the SORTOUT was a VSAM data set defined with the NOREUSE option and with DISP=SHR,
MFJSORT was removing existing records (as if the REUSE option was in use). This behavior has been
corrected, and MFJSORT now appends records to an existing NOREUSE VSAM file, regardless of the
disposition.

02583983 (480002)
• During a SORT, SORT-EBCDIC is no longer (incorrectly) converting HEADER, TRAILER FIELDS to

EBCDIC.

02596813 (503043)
• For various ICETOOL operations, the limits for the BI format have been corrected - SPLICE/SELECT

operations limit the BI format to 1500 bytes; for all the other ICETOOL operations, the limit is 8 bytes.

02827146 (662089)
• For SORT operations, an issue in which E15/E35 user exit record flags weren't being set correctly after

returning from the exit, to perform an insert, has been fixed. This particular issue only occurred when an
insert was performed while the user exit record flags were set to 0 (first record). The flags are now set
correctly to align with mainframe behavior.

02725254 (630030)
• During a SORT operation, SORT-EBCDIC PARM no longer (incorrectly) converts INREC FIELDS to

EBCDIC.

02602838 (505058)
• The Micro Focus file handler now passes correct information to the third-party file handlers for the

implementation of the FS_RENAME_FILE routine.

02794472 (559042)
• When writing records to a sequential spool file, it will not come under the affect of a semaphore.

Additionally, use the FLUSHSYSOUT=OFF configuration option to improve performance when writing to
the spool file; see FLUSHSYSOUT in the documentation for more details.

02805692 (651167)

Host Access for the Cloud

Back to the list

• The hacloud.properties file is now deprecated and the HACloud configuration details are stored in
an application-userprefs.properties file. After installing 10.0, the HA Cloud
startsessionserver script will rename any existing hacloud.properties to
hacloud_backup.properties. You need to port over any configuration settings from the old file to the new
application-userprefs.properties file.

(661065)
• The hacloud.properties file now includes a setting for the default location of a log file with

information about starting the session server as well as other logging fields.  

(502005)
• This release includes version 3.0.0.2 of the HACloud TN3270 emulator. HACloud uses a new

configuration file, application-userprefs.properties in %ALLUSERSPROFILE%\Micro Focus
\Enterprise Developer\hacloud (Windows) or $COBDIR/etc/hacloud (UNIX). If you are
upgrading from a previous Enterprise Developer release, and the old hacloud.properties
configuration file from the previous installation still exists, then the settings in this file take precedence,
with the exception of the setting to enable HTTPS communications to the session server endpoint. If
TLS was previously enabled, then after 10.0 the setting server.ssl.enabled=true needs to be
applied to application-useprefs.properties. It is recommended to migrate your configuration
settings over to the application-userprefs.properties file after the upgrade, and delete the
hacloud.properties file.

(656064)
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• In this release, Host Access for the Cloud will now attempt to retrieve credentials for the ESCWA
connection from a secret which will be shipped with the product by default (in microfocus/common/
readonly). You can override the default user credentials by supplying an escwacreds and/or an
mfdscreds secret. If these secrets do not exist then the default supplied user will be used.

(658050)

IMS Support

Back to the list

• A problem that caused a GSAM read error on restart when restoring a GSAM input file to a particular
CheckPointID has been fixed.

02686182 (566027)
• Corrected the MFS handling of PFKEYS pressed with no terminal data on segments in formats with

OPT=2 to make the behavior compatible with MFS on the mainframe.

02615830 (515062)

Interface Mapping Toolkit

Back to the list

• The base path is no longer part of the Service name field in the Properties dialog box of REST Web
service Deployment Server tab. (It is only visible in the Advanced Settings of the service name.)

02795415 (651091)

JCL Support

Back to the list

• This release provides support for up to DSNAME10 dataset name elements in ES_ALLOC_OVERRIDE
rules.

02800575 (651099)
• Restarted batch jobs now update the condition codes used when evaluating further restarts of the same

job. To this end, the recording of the result from a job restart has been changed to show the latest result
from steps that are within the restart range rather than the results from all steps in the job.

02575437 (477008)

Mainframe Access

Back to the list

• Performing an action in AWM that required a PDS DIR or CATDCB could result in an exception.

(487033)

Micro Focus Batch Scheduler Integration

Back to the list

• The CASAPI function for MFBSI is now ON by default, which improves performance and security. To
turn it off, meaning that CASSUB/CASOUT external commands submit the job, monitor the JCL region,
and retrieve the JEYSYMSG output, edit the CASAPI entry in the mfbsi.cfg file, or specify
CASAPI=OFF on the command line.

(544087)
• Control-M (CTM) for z/OS does not support embedded spaces in variable values. The CTM behavior of

MFBSI supports spaces, and in the case of AutoEdit variable values, removed the spaces and assigned
the rest of the value to the variable. This caused a problem when executing jobs that used AutoEdit
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variables that contained a space at the end of the line followed by a character because the character
was concatenated to the value of the last Autoedit variable. To accommodate spaces in AutoEdit
variables, this release introduces the CTM_SPACE variable, which enables you to change the default
MFBSI behavior to instead mimic the z/OS behavior: CTM_SPACE={[ON|YES]|[OFF|NO]}ON|YES -
Allow embedded spaces in CTM variables. Default is OFF|NO - Do not allow embedded spaces in CTM
variables.

02608301 (526024)

Micro Focus Directory Server

Back to the list

• When starting or stopping an enterprise server region using MFDS or the ESCWA user interface, the
casstart and casstop /m parameter would use the MFDS IP address rather than the host name,
which could result in an issue if TLS certificates were used that required a particular host name.

02603383 (505074)
• An issue introduced Patch Update 1 resulted in ESCWA not listing all enterprise server regions for

legacy import if they contained script data and the MF Directory Server was not sufficiently authorized
to import script data.

(636060)
• The Micro Focus Directory Server (MFDS) Start on System Start enterprise server region option on

the ESCWA General Properties page was not working because the Automated Execution Control
Enterprise Server Credentials were not being applied correctly.

02795649 (652065)
• When exporting enterprise server regions registered in the MF Directory Server using XML format,

regions for which the user did not have read/write access could also be exported.

(526005)
• Issues existed with importing enterprise server regions saved in JSON, XML, and Legacy format into a

MF Directory Server, which resulted in incorrect listener states and counts.

(559058)
• You can now control the execution and update permission for an enterprise server region's start and

stop, and on unrespondent scripts, by using a new LDAP Enterprise Server Administration security
resource class Scripts entity. If this security resource entity has been specified with appropriate access
control entries, the MFDS session will require Update permission in order for the authorized user to
modify a region s script or to enable or disable it. In addition, for a script to execute, then you must
specify Execute permission. See Class - Enterprise Server Administration in your product Help for more
information.

Note: This is not a region restriction, but applies to the MFDS instance where the region is
specified. If no security or MFDS Internal Security is configured for use then region scripts will not
be executed nor will they be able to be modified. The Scripts resource is not a security resource
created by default. It can be created by the ESCWA interface or other LDAP administration
configuration tools.

Important: In future product versions, the access control that uses the Scripts security resource
will be a requirement in order for any region s scripts to be executed or modified.

02822038 (499063)
• The default UI Session Timeout value for MF Directory Servers has changed from -1 (no timeout) to

600 seconds (10 minutes). The default value for the MF Directory Server API Session Timeout has
been reduced from 3600 seconds (an hour) to 1200 seconds (20 minutes).

(628068)
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PL/I Support

Back to the list

• In -noopt mode, the Open PL/I compiler failed to short circuit IF comparisons involving the NOT prefix
operator. This has been corrected.

(567011)
• Running CONTROLLED storage in a PL/I CICS program required that Force Phase-In be enabled to

prevent a SIGSEGV upon the second invocation of the PL/I Program. This has been corrected.

02260472 (258078)
• The Open PL/I compiler erroneously allowed OFFSETVALUE(POINTER)), namely

offsetvalue(sysnull()). The correct usage is: offsetvalue(binarvalue(sysnull())).

(386070)
• The precision of floating point arithmetic on x86 RedHat has been decreased from 63 to 52 to match

mainframe behavior.

(506106)
• The data type for the Signal1 field in the MQGMO structure (cmqp.inc) has been changed from: 3

Signal1 fixed bin(31) bigendian init(0) to 3 Signal1 pointer init(null()). This
data type change maintains a proper byte alignment in both 32- and 64-bit environments and better
aligns with the same field/structure on the mainframe.

02746362 (632026)
• A problem that prevented the EZASOKET interface from correctly interpreting when the caller was PL/I

has been fixed.

02851309 (681021)
• A problem that occurred when using the Windows API SetEnvironmentVariableA() to set an

environment variable in a language other than PL/I caused the PL/I GETENV() built-in function return an
incorrect modified environment variable value.

02605819 (505140)

Run-Time System

Back to the list

• The Java/COBOL application launcher - cobjrun - now supports Java command-line argument files.
See https://docs.oracle.com/en/java/javase/17/docs/specs/man/java.html#java-command-line-argument-
files for details on how these files should be constructed.

02744842 (636023)

SQL: Mainframe Batch Database Tools

Back to the list

• An error that occurred in SQLUTB UNLOAD when the specified size of an LRECL was less than
required for the row size has been fixed. The LRECL is now adjusted to accommodate the actual row
size.

02445817 (612038)
• A problem with unloading GRAPHIC data using DSNTIAUL has been fixed.

02677441 (550046)

Visual Studio IDE

Back to the list
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• The Submit JCL command now submits JCL files containing non-ANSI characters correctly.

02654119 02634016 02446652 (545056)

Known Issues
Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

• Enterprise Server for .NET is installed with Visual COBOL 10.0 but does not work. Micro Focus will
provide a fix for this in a later release.

• .NET COBOL projects only support Windows and Linux OS. The Create a new project dialog box in
Visual Studio, however, shows other platforms as supported.

• If, after installing the product for Visual Studio 2022, you cannot access the Micro Focus functionality,
execute the following command from a Visual Studio command prompt:

devenv /updateconfiguration

• The information available from Help > Help Contents in the new Data Tools client is out-of-date. For an
up-to-date information for the utility, check the Visual COBOL or COBOL Server product Help hosted on
the Visual COBOL documentation pages.

• In Visual COBOL 4.0 and 5.0 in an extremely small and limited set of cases, an issue could occur with
running .NET executables and .dll files, or JVM .class files, created with an earlier version of the
product. This issue only occurred if:

1. The application performs an IS NUMERIC condition test on a variable declared with USAGE
NATIONAL.

2. The application has been created with Visual COBOL 3.0 or earlier, then executed in Visual COBOL
4.0 or 5.0.

In these rare cases, the IS NUMERIC test could provide the wrong answer.

In order to resolve this issue, in Visual COBOL 6.0 and later, the .NET COBOL and JVM COBOL run-
times reject any program using IS NUMERIC on a NATIONAL item which was compiled with a version
5.0 or earlier of the product. You receive a "missing method" exception. To resolve the issue, you need
to recompile any programs that use this construct in the newer versions of Visual COBOL.

Program that do not use NATIONAL data, or those that have been recompiled in Visual COBOL 6.0 or
later are not affected.

• The ChangeMan Attachment models of release 5.0 and earlier are not working in the expected manner
under Enterprise Developer 8.0 or later. This is a result of several tools that are called with a static
value=`*` in the input parameter CMG_PROP_STATIC_SUBSYSTEM. If you want to run a ChangeMan
attachment model 5.0 and earlier under the current version of Enterprise Developer, you must remove
the static value=`*` from all CMG_PROP_STATIC_SUBSYSTEM input parameters.

Installation

System Requirements

Hardware Requirements
In general, most modern machines will have the required processor and available RAM to run the Micro
Focus products under Windows effectively. For planning purposes, you should consider having a minimum
of 2GB of RAM though Micro Focus recommends at least 4GB of RAM for optimal performance.
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Visual COBOL and Enterprise Developer for Visual Studio

Visual COBOL and Enterprise Developer have the following requirements in addition to the requirements of
Microsoft Visual Studio. See the Visual Studio documentation for details of the Microsoft requirements.

The disk space requirements are:

Product Maximum Disk Space
Requirements

Sentinel RMS License Manager

Visual COBOL 1.2GB 75MB

Enterprise Developer 2.3GB 75MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Visual COBOL and Enterprise Developer for Eclipse on Windows

The disk space requirements are:

Product Maximum Disk Space
Requirements

Sentinel RMS License Manager

Visual COBOL 3.7GB 75MB

Enterprise Developer 4.5GB 75MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Operating Systems Supported
Note: If you are using Visual COBOL or Enterprise Developer on a 64-bit operating system, you can
produce either 32-bit or 64-bit applications.

For a list of the operating systems each individual product in this package supports, check the Supported
Operating Systems and Third-party Software section on the Micro Focus OpenText Support for Micro
Focus Products Web site. For example, https://www.microfocus.com/documentation/enterprise-developer/
ed90/ED-Eclipse/GUID-7ECA1D86-EC87-454D-B666-1047527FD9BF.html.

Software Requirements
Note: This product includes OpenSSL version 3.0.8.

Windows

Note: The setup file will check your machine for whether the prerequisite software is installed and will
install any missing prerequisites and the product components.

Visual COBOL and Enterprise Developer for Visual Studio:

You must have Microsoft's Visual Studio 2022 version 17.8 or later installed in advance.

You need one of the advanced versions of Visual Studio listed below:

Professional, Enterprise or Community Edition - see the next section for the Visual Studio components
you must install.

Microsoft's Visual Studio Express Edition is not supported.
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Important:

• When installing Visual Studio, ensure you select the Help Viewer component for installing if you
want to view the Visual COBOL product help inside Visual Studio. When you select components to
install in the Visual Studio installer, click Individual components and check Help Viewer in the
Code tools section.

The following software is also required:

• Microsoft .NET Framework 4.7.2. This is included with Visual Studio.

Visual COBOL and Enterprise Developer for Eclipse:

The following requirements apply to both Visual COBOL and Enterprise Developer:

• A 64-bit Windows is required. 32-bit Windows is not supported. See Installation in Known Issues and
Restrictions.

• The setup file installs Visual COBOL and the 64-bit version of Eclipse 4.28 (2023-06).

Visual COBOL only supports the 64-bit version of Eclipse. You can use the 64-bit Eclipse to create both
32-bit and 64-bit applications.

• The setup file installs Adoptium's OpenJDK Temurin 17 (LTS) with HotSpot.
• The setup file also installs Microsoft's Visual C++ 2012 and 2015-2022 Redistributables.

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.

• Java 17 (64-bit) or 21 is required to run the Eclipse IDE. The recommended version is Adoptium's
OpenJDK Temurin 17 (LTS) with HotSpot. On Windows, the installer automatically installs Adoptium's
OpenJDK Temurin 17 (LTS) with HotSpot. You can download Adoptium's OpenJDK Temurin 17 (LTS)
with HotSpot from Adoptium's Web site and unpack the archive anywhere on your machine.

• Visual COBOL requires a 64-bit Java installation to run a 64-bit Eclipse.
• Microsoft Windows SDK and Microsoft Build Tools: Various actions and operations within your COBOL

development environment depend on certain files that Microsoft distributes in the following package: the
Windows SDK package. See Microsoft Package Dependencies for a full list of actions and operations
that require one or both of these packages.

By default, the product installation installs the latest versions of the Microsoft Windows 10 SDK, and the
Microsoft Build Tools for Visual Studio 2017, to their default locations.

If you need to use any other version of these packages, or use them installed to a non-default location,
use the cblmx`s command line utility post-installation to manage this; see Managing the Microsoft
Build Tools and Windows SDK Packages for more information.

Installation Restrictions and Requirements
Before starting the installation you should be aware of the following:

• Visual COBOL and COBOL Server cannot coexist on the same machine.
• Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE

(Visual Studio or Eclipse) you install.
• You need to be logged in with a user-ID that has write access to the registry structure under

HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

• If you are installing this as an upgrade, make sure that none of the product files are in use when you
start the installation. Also, the Visual Studio Help Viewer must not be opened.

• You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
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software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

Downloading the Products
1. Use the download links in the Software Downloads section of the Micro Focus Software Licenses and

Downloads Web site.

Installing the Products
Use the individual setup files to install each product from the Micro Focus Academic Program package as
follows:

Windows

1. Run the productname.exe file and follow the wizard instructions to complete the installation.
2. After installing the Visual Studio 2022 product, if you cannot access the Micro Focus functionality, you

need to execute the following command from a Visual Studio command prompt:

devenv /updateconfiguration

After Installing

Visual COBOL and Enterprise Developer for Visual Studio

You are now ready to run Visual COBOL or Enterprise Developer. You need to start the version of Visual
Studio for which you have installed this product. By default, the Help is available online on the Micro Focus
SupportLine Web site: https://www.microfocus.com/support-and-services/documentation/.

To see the Help:

• Click Help > Micro Focus Product Help > Product Documentation.
• Alternatively, press F1 inside the editor or from a UI part.

This opens the Visual COBOL help or Microsoft's MSDN depending on which keyword in the editor or
part of the UI you are querying.

Note: Your Visual Studio might be configured to show the local help. To switch to online help, click
Help > Set Help Preferences > Launch in Browser inside Visual Studio.

Refer to the Welcome and Product Information sections in your product Help. Here, you will find information
on getting started including tutorials and demonstration programs.

Visual COBOL and Enterprise Developer for Eclipse

If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the perspective you
are working with after installation:

1. Open the existing workspace with this product.

You may receive some warnings or errors which you can ignore.
2. Make sure you are in the perspective you need to reset by clicking Window > Perspective > Open

Perspective > Other.
3. From the Open Perspective dialog box, click the perspective you want to reset.
4. Click OK.
5. Click Window > Perspective > Reset Perspective.
6. When prompted, click Yes.
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7. Reapply any customizations.

To view the help:

• Click Help > Micro Focus > Product Documentation.
• Alternatively, press F1 inside the editor or from a UI part.

This opens a browser with the Visual COBOL help.

Note: By default, Eclipse is configured to show the local help. See the installation notes within the
product Help, for instructions about how to switch to local help.

Refer to the Welcome and Product Information sections in your product Help. Here, you will find information
on getting started including tutorials and demonstration programs.

Repairing

Windows

If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

Important: Before performing a repair of the installation, Micro Focus recommends that you create
backups of any configuration files of the product that you might have changed.

To repair your installation:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product, and select Repair.

UNIX

If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Before performing a repair of the installation, Micro Focus recommends that you create backups of any
configuration files of the product that you might have changed.

Uninstalling

Windows

To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.

During the uninstall process, only those files added during the installation (to the installation and Samples
directories) are removed. If the installation installed the Microsoft Windows 10 SDK or Microsoft Build Tools
packages, these are left in place, although the Micro Focus-related registry entries for these packages are
removed.

If the product directory has not been removed, delete any unwanted files and subdirectories within it using
Windows Explorer.

Note: The installer creates separate installations for Visual COBOL, Enterprise Developer, Micro
Focus Enterprise Server for .NET, and Micro Focus License Administration. Uninstalling only Visual
COBOL does not automatically uninstall Micro Focus Enterprise Server for .NET, the Micro Focus
License Manager or any of the prerequisite software.
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Micro Focus Enterprise Server for .NET must be uninstalled before you remove Visual COBOL. To
completely remove the product you must uninstall the Micro Focus License Manager as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Some registry entries are not removed by the uninstallation process and you need to manually delete
them.

The following folders might not be removed:

• Micro Focus Product Name folder in the Start menu - you can delete it manually.
• %systemdrive%\Users\Public\Documents\Micro Focus - includes the binaries and the log

files of the samples which you have built.
• %ProgramData%\Micro Focus - includes some data files used by the Micro Focus licensing system.
• %Program Files%\Micro Focus - you can delete it manually.

Copyright and Disclaimer
© Copyright 2024 Micro Focus or one of its affiliates.

The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS IS" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.

Any links to third-party Web sites take you outside Micro Focus Web sites, and Micro Focus has no control
over and is not responsible for information on third-party sites.
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